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The image below shows the interrelationships among the guides in the series.  This 

guide is Getting Started with Epi Info™ - An Overview of Tools.
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Preface 

 

Epi Info™ 7 is a public domain suite of interoperable software tools designed for the 

global community of public health practitioners and researchers. Perform data 

analysis with epidemiologic statistics, maps, and graphs. Build data entry forms, 

construct a database, and customize statistics applications. Physicians, 

epidemiologists, and public health officials without a tech background can easily 

work with critical data using Epi Info™ tools. 

Epi Info™ 7 is free of charge. You can Download Epi Info™ 7 from the Centers for 

Disease Control and Prevention (CDC) website. 

There are many resources, components, and utilities in the Epi Info™ Suite of 

Tools.  Each major tool has its own guide to help you make the best use of it. The 

graphic on the opposite page shows the full Epi Info™ Guide Series and the 

interrelationships between the guides. Each guide in the series has a similar 

graphic. The current guide is highlighted with a red bookmark icon ( ).  This guide, 

Getting Started with Epi Info™ - An Overview of Tools, contains a high-level 

description of each tool. Use the stand-alone guides for each Epi Info™ tool 

independently, or in conjunction with related guides for greater functionality. In 

some cases, related guides are important prerequisites to using the tool discussed in 

the current guide. The prerequisite documentation has a red star icon ( ).  In other 

cases, you may find optional guides informative, and the optional documentation is 

shown with a green information icon ( ).  For detailed instructions on using any of 

the Epi Info™ tools, refer to its specific guide in the Epi Info™ Guide Series.

https://www.cdc.gov/epiinfo
https://www.cdc.gov/epiinfo
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Downloading and Setup

 
Epi Info™ 7 can be downloaded from the CDC website under the Epi Info™ pages 

(https://www.cdc.gov/epiinfo/). Two versions of the software are available: a ZIP 

download file and an installation file. ZIP files are also known as archive or 

compressed files. These files should open on any Windows computer. You can use 

many different utilities to open ZIP files, including WinRAR and WinZip. The 

following section will walk you through using the Windows archive file viewer to 

extract the files.  

An archive file is a container that can store other files. Because the Epi Info™ 7 

software is composed of many individual files, it is not practical for you to download 

each file individually. All files needed to run Epi Info™ 7 are placed in a single 

container file. 

The installation file simply needs to be run (or executed) to install Epi Info™ 7. You 

may not, however, be able to use the installation file if you do not have 

administrative rights or elevated privileges on your computer. 

Extracting the Archive 

 

1. Open your web browser and navigate to https://www.cdc.gov/epiinfo/pc.html. 

2. Click the button: Download ZIP File. The file will be downloaded to the 

folder you use for your downloads. 

3. Click the Open file link or double-click the file to open it.  

Note: Some computers may open the ZIP file in a different program such as WinZip 

or WinRAR.  The instructions provided here assume that the file has been opened 

using Windows Explorer. 

https://www.cdc.gov/epiinfo
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4. Select the contents of the archive and drag them onto the desktop.  This will 

copy the Epi Info™ 7 program files to the desktop. After completion, a pair of 

icons will appear on your desktop —- the Epi Info™ 7 folder and the 

Launch Epi Info™ 7 menu launcher. 

Navigating Epi Info™ Tools

 

Double-click the Launch Epi Info™ 7 icon to open the Epi Info™ 7 main menu. 

Choose from the primary tools of the Epi Info™ suite: Form Designer (Create 

Forms), Enter Data, Epi Map (Create Maps), StatCalc, Classic Analysis, and the 

Visual Dashboard. The Epi Info™ 7 version number and the currently installed 

language are shown on the status bar at the bottom. 

 

Epi Info™ 7 For Desktop Main menu 
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Dynamic Form Design and Business Logic 

Epi Info™ Form Designer

 

In Epi Info™ 7, Form Designer creates and customizes forms. You configure 

properties for each field on the form and specify the tab sequence. In Epi Info™ 7, 

data collection is organized by projects. Each project can have one or many forms 

which can have one or many pages. On each page, you can place one or many labels 

and data entry fields to collect individual data values. 

There is a variety of field types that you can use to collect data.  Some of the most 

common types of fields include text boxes, number fields, drop-down lists, code fields 

for automatically populating data, and mutually exclusive option fields to name a 

few.  Label fields and command buttons can be added to the page to add 

instructions and perform functions.  Find the full list of field types on the Epi Info™ 

website about How to Use Fields. 

Unlike some data collection tools, Epi Info™ Form Designer allows you to position 

fields on a page as they might appear in a printed form. This is helpful when doing 

data entry from completed data sheets. When the form is used with Epi Info™ Web 

Survey or on mobile devices, the form is responsive to the screen size and 

automatically adjusts how the questions are shown, and according to the tab order.  

By default, data is stored in the project’s MS Access database file, but Microsoft 

SQL Server databases can also be used. Form Designer handles all database 

management aspects such as the table creation, managing parent-child table 

relationships and their primary and foreign keys. Form Designer is a database 

design environment. As you create a form you also build and define the database. To 

start Epi Info™ Form Designer, click the Create Forms button on the main menu. 

For more details on Form Designer, review the Epi Info™ Guide to Form Designer. 

https://www.cdc.gov/epiinfo/user-guide/form-designer/how-to-use-fields.html
https://www.cdc.gov/epiinfo/user-guide/form-designer/how-to-use-fields.html
https://www.cdc.gov/epiinfo/user-guide/form-designer/introduction.html
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Epi Info™ Check Code

 

In Epi Info™ you can apply business rules, data validation, and customize the data 

entry process by using Check Code. With Check Code, your form can check for 

errors during data entry, automatically execute calculations, and highlight 

messages based on specific answers. You can skip or highlight specific fields or 

parts of the survey based on conditions you specify. Check Code helps you protect 

against many common data entry errors to reduce the amount of post collection 

data cleaning. Examples of Check Code operations include: 

• Displaying messages that appear as part of the survey. 

• Calculating fields from mathematical operations. 

• Checking one or more fields for relationships such as ensuring a date or 

number is within an expected range. 

• Checking for inconsistencies. For example, Check Code will disable fields for 

hospital admission date and length, if respondents state they were not 

hospitalized. 

• Automatic indexing of fields for faster searching. 

• Automatic searches during data entry. 

Start Check Code editor from within Form Designer by clicking the button on the 

menu bar for Check Code.  Another way to open it is by right clicking a field on the 

page in Form Designer and selecting Field Check Code. 

For more about Check Code, see the Epi Info™ Guide to Check Code.  

https://www.cdc.gov/epiinfo/user-guide/check-code/checkcodeintro.html
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Epi Info™ Command Reference 

 

Epi Info™ 7 is easy to operate in interactive mode, but step-by-step operations 

require a process like scripting. In Epi Info™ you can program a series of steps to 

guide and limit the data entry process, restructure data, and do analyses. 

In Form Designer and Classic Analysis, programming comprises interacting with a 

series of dialogs producing statements that carry out instructions. You can edit 

statements or directly type them in the Form Designer Check Code Editor or the 

Classic Analysis program editor. The Epi Info™ Command Reference is a resource 

to view and discover details of syntax and usage. 

Some commands work only with specific tools. Data entry commands are called 

Check Code commands. These commands are constructed by the Check Code editor 

in Form Designer, and they run during data entry.  Examples of Check Code 

commands include Hide, Highlight, and Disable which are used to hide, 

highlight, or disable fields during data entry. Epi Info™ Commands constructed in 

Classic Analysis run in the program editor within Classic Analysis. Examples of 

Analysis Commands include Freq, Tables, Logistic, and Graph. These commands 

produce frequencies, 2 x 2 (two by two) tables, logistic regression analyses, graphs 

and charts. 

View details of all commands available in Epi Info™ in the Epi Info™ Command 

Reference. 

 

  

https://www.cdc.gov/epiinfo/user-guide/command-reference/introduction.html
https://www.cdc.gov/epiinfo/user-guide/command-reference/introduction.html
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Epi Info™ Functions and Operators

 

Functions and operators are strings of code within commands that accomplish 

common tasks. For example, you can use functions and operators to: 

• Convert numbers to text, or text to numbers. 

• Extract the year portion from a date string. 

• Add two numeric values to produce a sum or do other arithmetic operations. 

• Calculate the number of days between two dates. 

Functions modify the value of one or more variables to return a result. For example, 

the ROUND function will round a value down to the nearest whole number. 

Operators combine or compare two values. Simple math is done with the +, -, *, and 

/ operators for addition, subtraction, multiplication, and division, respectively. 

Other comparison operators return a true or false result.  The detailed descriptions 

and usage of the functions and operators in Epi Info™ 7 can be found in the guide 

Epi Info™ Functions and Operators.  

https://www.cdc.gov/epiinfo/user-guide/functions-and-operators/functionsandoperatorsintro.html
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Tools for Capturing and Transporting Data 

Epi Info™ Enter Data

 

The Enter Data program displays forms created in Form Designer. Enter Data 

controls the data entry process using settings and Check Code specified when the 

form was designed. Data entered is stored in Microsoft Access format data tables, 

but you do not need Microsoft Access to collect data with Enter Data. If you have 

Microsoft SQL Server installed, you can choose to use a SQL Server database as the 

data repository.  The data repository for the project is chosen at the time the project 

is created. 

Enter Data populates the project data tables. Entering data causes the cursor to 

move from field-to-field, page-to-page, and saves data when moving between pages. 

If you try to exit a page before saving data, the system will ask if you want to save 

the changes. 

In Enter Data, use the Find function to locate records based on a series of matching 

values that you specify. When entering data into a sub-ordinate or related form, 

you’ll use the Back button to take you back to the previous form in the relationship. 

Start Enter Data by clicking the Enter Data button on the main menu. If you are 

already working on a form in Form Designer, you can quickly start Enter Data by 

clicking the Enter Data button on the tool bar. This closes Form Designer and 

opens the form in Enter Data. Enter Data allows entering new data, modifying 

existing data, or searching for records. For more detailed information, go to the Epi 

Info™ Guide to Enter Data. 

 

https://www.cdc.gov/epiinfo/user-guide/enter-data/introduction.html
https://www.cdc.gov/epiinfo/user-guide/enter-data/introduction.html
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Epi Info™ Web Survey

 

The Epi Info™ Web Survey system (EIWS) provides the ability to distribute surveys 

to participants and remotely collect data.  Remote collection and distribution of 

survey responses is a powerful feature of Epi Info™ 7. It provides survey designers 

access to a wide variety and number of participants. Publish survey forms to any 

pre-configured web server hosted by your institution or an outside party. When 

published, Epi Info™ creates a survey specific Universal Resource Locator (URL) or 

website address.  After designing and publishing the survey, you can distribute the 

URL by email, by posting it on a web page, or using other methods such as a QR 

code on a postcard or sign. Participants engage with web survey and submit their 

responses through a web browser or mobile device. After the participants submit 

responses, you can download the responses into the original Epi Info™ 7 project for 

analysis or export them to other tools. If the Epi Info™ Survey Manager is installed, 

you can use other functions to facilitate the process.  For more on the Epi Info™ 

Web Survey tool, refer to the Epi Info™ Guide to Web Survey. 

Epi Info™ Survey Manager

 

The Epi Info™ Survey Manager is an optional component that works exclusively 

with the Epi Info™ Web Survey system (EIWS). You must have EIWS deployed in 

order to use the Epi Info™ Survey Manager. While EIWS was initially designed to 

collect responses from anonymous participants, the Epi Info™ Survey Manager 

allows you to send individual survey links by email to specific respondents.  You can 

publish new surveys from an Excel file and update existing surveys. The Epi Info™ 

Survey Manager also provides a dashboard with the status of surveys and 

responses, and other useful features. For more information, see the Epi Info™ 

Guide to Survey Manager.  

https://www.cdc.gov/epiinfo/user-guide/survey/introduction.html
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Epi Info™ Mobile Companion Applications 

 

There are two apps available for mobile devices to work with Epi Info™. One is for 

Android devices and the other is for Apple iOS devices.  They both allow you to 

transfer forms to a mobile device and remotely collect data. The ability to load Epi 

Info™ forms onto a mobile device allows you to collect data in places lacking 

information technology infrastructure and for activities that could benefit from 

mobility, GPS tracking, or photographic capabilities such as barcode scanning. After 

data collection, perform simple analysis with the Analyze Data function or view 

geographic data using the built-in mapping function. These tools do not contain the 

full Epi Info™ functionality; however, you can transfer data from the mobile device 

to a PC for more complex analyses. The mobile application also contains a full 

featured StatCalc tool like the one found in Epi Info™ 7.  For more information 

about using Android devices, go to the Epi Info™ Guide to the Mobile Companion for 

Android.  For more information using Apple devices, go to the Epi Info™ Guide to 

the Mobile Companion for iOS. 

 

Epi Info™ Cloud Data Capture
 

Epi Info™ Cloud Data Capture offers a platform for distributed multi-user data 

entry with centralized data management, enterprise database integration, 

distributed analysis, and role-based access. It enables those you authorize to collect 

and securely manage data over the web or within a local area network. Users that 

enter data into Cloud Data Capture are managed with a user ID and password and 

must sign into the system.  For more information on this tool, go to the Epi Info™ 

Guide to Cloud Data Capture.  

https://www.cdc.gov/epiinfo/user-guide/android/androidintro.html
https://www.cdc.gov/epiinfo/user-guide/android/androidintro.html
https://apps.apple.com/in/app/epi-info-companion/id762428884
https://apps.apple.com/in/app/epi-info-companion/id762428884
https://www.cdc.gov/epiinfo/cloud.html
https://www.cdc.gov/epiinfo/cloud.html
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Epi Info™ Data Packager

 

The Epi Info™ Data Packager tool provides an easy way to share data with other 

users or to merge data collected by multiple users into a single database for 

analyses. The Data Packager does this by offering the option to package and export, 

as well as import data from Epi Info™ projects. 

Data Packager also has several security features for safer data sharing. Some of the 

security features supported by Data Packager include password encrypted data 

packages and data de-identification through omitting specific database fields. You 

can also subset the data by specifying conditions for record selection. Data Packager 

also offers the option to save package settings for future use. Once packaged, you 

can safely send the encrypted package to others. If you receive an encrypted data 

package, use the Import Data option to import the data into your Epi Info™ 7 

project. 

Start Data Packager by selecting Enter Data from the Epi Info™ 7 main menu and 

open a project and form. The Package for Transport option is in the toolbar under 

File > Package for Transport. The Import Data from Data Package option is 

located under File > Import data > From data package. To learn more, go to the 

Epi Info™ Guide to Data Packager. 

  

https://www.cdc.gov/epiinfo/user-guide/data-packager/datapackagerintro.html
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Tools for Analysis, Visualization, and Reporting 

Epi Info™ Classic Analysis 

Epi Info™ Classic Analysis lets you manipulate, manage, and analyze data. Classic 

Analysis acts as a statistical toolbox providing many ways to transform data and 

run statistics. Data can be selected, sorted, listed, or manipulated with a series of 

commands, functions, and operators. Available statistics include frequencies, 

means, 2 x 2 tables, and more advanced processes such as Kaplan-Meier Survival 

Analysis and Logistic Regression. Start Classic Analysis by clicking on the Classic 

button on the main menu. Classic Analysis can read data from a variety of formats 

like MS Access, Excel, SQL server, CSV files, MySQL, MongoDB, and PostgreSQL. 

It offers simple and intuitive tools, producing many useful statistics and graphs for 

epidemiologists and other public health professionals. As data volume increases, 

rerun saved scripts for updated results. For more information, go to the Epi Info™ 

Guide to Classic Analysis. 

  

https://www.cdc.gov/epiinfo/user-guide/classic-analysis/classicanalysisintro.html
https://www.cdc.gov/epiinfo/user-guide/classic-analysis/classicanalysisintro.html
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Epi Info™ Visual Dashboard

 

Epi Info™ Visual Dashboard is one of the analysis modules in the Epi Info™ suite 

of tools. The Visual Dashboard is intuitive and simple to use. With the use of 

gadgets, we minimize the need for programming code. Use Analysis gadgets in 

Visual Dashboard to sort, list, and manipulate data. Statistical analyses tools 

available in Visual Dashboard include frequencies, means, 2x2 tables, and more 

advanced statistical calculations such as linear regression and logistic regression. 

Visual Dashboard has graphing functionality to display data as an Epi Curve, 

Pareto Chart, and several other bar and column charts.  

Start Visual Dashboard from the Epi Info™ 7 main menu by clicking the Visual 

Dashboard button. You can also select Dashboard from the Enter Data main 

menu after loading an Epi Info™ project.  For more information, refer to the Epi 

Info™ Guide to Visual Dashboard. 

  

https://www.cdc.gov/epiinfo/user-guide/visual-dashboard/visualdashboardintro.html
https://www.cdc.gov/epiinfo/user-guide/visual-dashboard/visualdashboardintro.html
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Epi Info™ StatCalc: Statistical Calculators

 
Epi Info™ StatCalc is a statistical calculator producing summary epidemiologic 

information. Use the resulting summary data independently of an Epi Info™ 7 

project or apply it to six types of calculations. 

• Population Survey, Cohort or Cross-Sectional, and Unmatched Case-Control 

for Sample Size and Power calculations.  

• Chi-square for trend, which tests for study trends. Uncover a series of 

increasing or decreasing exposures while studying the current data. 

• Tables (e.g., 2 x 2, 2 x n) – Both single and stratified 2 x 2 tables produce odds 

and risk ratios (relative risks) with confidence limits. Use tables with several 

types of Chi square tests, Fisher exact tests, Mantel-Haenszel summary odds 

ratios and Chi squares, and associated p-values. These calculations are like 

those produced in Classic Analysis and Visual Dashboard. 

• Poisson (rare event vs. std.) – A Poisson distribution predicts probability 

around a known average rate of occurrence. 

• Binomial (proportion vs. std.) – A binomial distribution states the probability 

of positive outcomes in a two-outcome study (yes/no). It is based on the 

number of observations and the expected percent of positive outcomes. 

• Matched Pair Case Control Study – calculates the statistical relationship 

between exposures and the likelihood of becoming ill in a patient population. 

Start StatCalc, click the StatCalc button on the Epi Info™ 7 main menu.  For more 

information, refer to the Epi Info™ Guide to StatCalc.  

https://www.cdc.gov/epiinfo/user-guide/statcalc/statcalcintro.html
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Epi Info™ Epi Map

 

The Epi Info™ 7 Epi Map tool displays geographical data on a map. Epi Map can 

display multiple views from the same dataset. Filter and display Epi Map datasets 

over a span of time. Tweaking these features allows you to construct customized 

public health data maps. 

Information displayed in the main map window appears as layers. Data layers add 

information as case cluster maps, choropleth maps, or dot density maps. Reference 

layers add geographical boundaries and markers from shapefiles, a map server, or 

KML (Keyhole Markup Language) files. Using reference layers allows Epi Map to 

identify and designate display settings from both internal and external data 

sources. You can modify or filter map data using data layers.  To learn more, go to 

the Epi Info™ Guide to Epi Map. 

Epi Info™ Nutritional Anthropometry

 

Collect, analyze, and graph child growth data with Epi Info™ 7 Nutritional 

Anthropometry tool. Previously referred to as the NutStat module, the Nutritional 

Anthropometry tool includes a data entry form that calculates z-scores and 

percentiles while adding fresh data. The Nutritional Anthropometry tool creates 

growth charts in Visual Dashboard while adding z-scores and percentiles to existing 

datasets. 

Using the Nutritional Anthropometry tool in Epi Info™ 7, you can select a required 

growth reference. Choose between four growth references charts: CDC 2000 Growth 

Reference, WHO Child Growth Standards, WHO Reference 2007, and CDC/WHO 

1978.  

  

https://www.cdc.gov/epiinfo/user-guide/maps/mapsintro.html
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Epi Info™ Options 

Epi Info™ Options are used to specify settings that may affect more than one tool. 

Options may also control settings that persist between sessions. For example, if 

every time you use Epi Info™ tools you want data in Yes/No fields showing On, Off 

and Unknown, specify those text strings in Options. Yes/No fields display the 

specified text in Classic Analysis, Visual Dashboard, Maps, and other outputs. The 

settings in Options are saved to the Epi Info™ configuration file. 

General 
Options on the General tab set default database formats for new projects and for 

Classic Analysis, map service keys for mapping and geocoding, and a default 

working directory. 

  

General Options Tab 
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Language 

 

Options on the Language tab let you use the Epi Info™ 7 tools in other languages in 

addition to English. Epi Info™ comes with translations for Spanish and French 

already imported into the system. You can import other translation files for Arabic, 

Chinese, Georgian, Russian, and Vietnamese, available for download from the Epi 

Info™ Translations web page. If you need another language not listed, you can 

create and import your own custom translation file.  Translation works without 

changing the names of files. With the translation file imported, you can seamlessly 

switch languages from the main menu. For more information on how to use Epi 

Info™ in other languages, refer to the section on Language and Translation later in 

this guide. 

 

 

Language Options Tab 

https://www.cdc.gov/epiinfo/support/downloads/translations.html
https://www.cdc.gov/epiinfo/support/downloads/translations.html
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Analysis 
Select the Analysis tab to view current settings and control performance options 

and data output for Classic Analysis. Your new analysis settings take effect when 

launching Classic Analysis. 

 

Analysis Options Tab  

▪ Yes As, No As, and Missing As options allow you to customize the display 

of yes-no variable values in analytic output and listings. Data in yes-no 

variables is stored as 1 for yes and 0 for no, but Epi Info™ displays the values 

according to the settings here. Select from the options available in the drop-

down list or type your own custom display values. 

▪ Show Complete Prompt displays prompts rather than variable names in 

output. 
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▪ Show Percent includes percentages in frequency and tables output. Yes, is 

shown as On, or (+). No is shown as Off, or (-).  

▪ Include Missing Values, when checked, will include missing data results.  

▪ Process Records determines whether undeleted, deleted, or all records will 

be used in statistical procedures.  In Epi Info™, deleted records are only 

marked for deletion, but remain in the database until a physical or 

permanent deletion is done.  Therefore, you can switch Process Records to use 

“Deleted Records Only” to run commands on those deleted records, or 

undelete them, if needed.  Although Classic Analysis reads data of various 

formats such as Excel, CSV, REDCap, and others in addition to Epi Info™ 

projects, the Process Records feature only applies to Epi Info™ projects. 

Plug-ins 
Options on the plug-ins tab control and visualize data using Analysis Gadgets in 

Visual Dashboard. The record count, data filtering, data re-coding, and formatting 

gadgets are organic to the Visual Dashboard module. Analysis Gadgets are highly 

configurable. You can add additional gadgets with future releases of Epi Info™ 7. 

 

Plugins tab  
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Web Survey Options

 

Options on the Web Survey tab control settings required for publishing a survey 

and collecting data. You must have installed  Epi Info™ Web Survey system or have 

access to a version installed by your organization.  For example, the CDC has Epi 

Info™ Web Survey installed for CDC staff to use. If you have access to Epi Info™ 

Web Survey system, you can find features by designating the endpoint address and 

binding protocol. The endpoint address is the URL where Epi Info™ Web Survey 

(EIWS) Manager Service is running. These settings should be provided by your 

EIWS System administrator.. If you are a CDC staff member or contractor, contact 

the Epi Info™ development team for access to CDC’s EIWS system. 

 

 

Web Survey Options tab 
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Cloud Data Capture Options

 

Options on the Cloud Data Capture tab hold information needed to access the Epi 

Info™ Cloud Data Capture system. To use Cloud Data Capture, choose it from the 

tab control settings. Select either your installation or an installation deployed by 

your organization. Designate the endpoint address and binding protocol. The 

endpoint address, Windows authentication, and binding protocol provide 

security to the system and access to individual forms. Your Epi Info™ Cloud Data 

Capture system administrator will provide proper settings. 

 

 

Cloud Data Capture Options  
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I & Coding 

 

Use the I&O Coding Options to provide the resource file used by Epi Info™ for 

industry and occupation codes.  Information about a person’s work can help 

determine if hazards, injuries, or illnesses are higher among certain industries and 

occupations. Additional information can be found at the Collecting and Using 

Industry and Occupation Data website.  

 

 

I&O Coding Options tab 

  

https://www.cdc.gov/niosh/topics/coding/
https://www.cdc.gov/niosh/topics/coding/
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Epi Info™ Language and Translation 

Introduction

 
Translation of Epi Info™ 7 programs into non-English languages begins by setting 

the language to use on the Tools > Options > Language tab.  If your language is 

not listed, you can import additional translation files or create one to import. Learn 

more by reading How to Create a New Translation File. Run the Create 

Translation File utility and place commonly used English phrases in an MS 

Access database. Insert the database in any directory accessible by Epi Info™ 7. It 

is recommended that you create a Translation subdirectory under the main 

installation directory (usually \Epi Info™ 7). Place all translation database files 

with the MDB extension under \Epi Info™ 7\Translation. Install or load 

language translation definitions without affecting program functionality. You don’t 

need to alter any filenames. After the language definition file is loaded, you can 

exchange one language to another from the main menu. Epi Info™ comes pre-

loaded with translations for Spanish and French. Other translation packages for 

Arabic, Chinese, Georgian, Russian, and Vietnamese are available on the web page 

for Epi Info™ Translations. 

  

https://www.cdc.gov/epiinfo/support/downloads/translations.html
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How to Translate Epi Info™ 7

 

Epi Info™ 7 is designed for easy translation into languages other than English. 

Almost all the English phrases that can safely be translated are contained in a table 

in the translation file or database. Commands, functions and other reserved words 

in the Classic Analysis and Check Code programming languages should not be 

translated. However, you can translate the screen prompts that lead to their 

generation. Each Epi Info™ 7 component or object, has its own row in a translation 

file.  

Multiple languages can be loaded at a time. You will need a completed translation 

file for a new language. The User Community and the Epi Info™ Team will develop 

translation files as Epi Info™ 7 is distributed to the field. Language translations 

will be available through the Epi Info™ website. 

Currently, there are two ways to use Epi Info™ 7 with a language other than 

English. 

• Epi Info™ is pre-packaged with translation files for Spanish and French 

already imported. 

• If you are not using a translation file, create a new translation file for the 

language of your choice. For more information, see the section How to Create 

a New Translation File.  

• If you obtained a translation file from the web page or from someone else, use 

Import Translations to bring those translated phrases into the latest 

version of Epi Info™ 7. For more information, see the section Use an Existing 

Translation File. 
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How to Create a New Translation File 

 

Make sure your Windows locale setting is adjusted with your language location 

before following these steps. You will need Microsoft Access to translate the phrases 

to your target language. 

1. From the Epi Info™ 7 main menu, select Options. 

2. Click the Language tab. 

3. Click the Create Translation File button. 

 

Translation File Languages 
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4. A window will pop up asking you to name the generated translation file. We 

recommend including the specific language in the file name. For this 

example, we named the file ItalianEpi7. Save the file to any location. 

 

Creation of translation file 

 

5. Click Save. 

6. After several seconds when the Translation File is created, the message 

Translation file is ready for use” will be displayed. The translation file 

has been created and is ready to be translated. Since the file is created in the 

Microsoft Access Database format, the new file will have an MDB extension. 

 

Translation file is ready 
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• Use Microsoft Access to open the new translation file. 

• Open the Cultural Resources table. 

• Translate words and phrases in the ResourceValue column from English 

into the new language.  

• Do not change the value of the English words and phrases in the 

SourceValue column. 

• If the phrase contains a number in curly braces such as “{0} is a reserved 

word.” then leave the curly braces and number alone – don’t translate or 

change that part. In this example, only translate the English phrase “is a 

reserved word.” Some text strings have multiple sets of curly braces and 

numbers such as “Processed a total of {0} unique record identifiers in 

{1}.” Just translate the English phrases “Processed a total of” and 

“unique record identifiers in”. The curly braces and numbers will contain 

values produced by the system when it runs. 

• After you translate each of the rows contained in the table, follow the steps in 

the next section to import the translation file and run Epi Info™ 7 using the 

new language. 

 

 

Cultural Resources Table 
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Use an Existing Translation File 

 

Make sure your Windows locale setting is adjusted with your language location 

before following these steps. You must have a translation file which is in the 

Microsoft Access Database (MDB) format. This translation file contains the 

completed language translation you need to complete this section. If you didn’t 

create your own translation file as described in the previous section, you can find 

and download examples of completed translation files from the Epi Info™ 

Translations web page. 

1. From the Epi Info™ 7 main menu, select Options. 

 

Import Language Database Settings 

 

2. Click the Language tab and select Import Translations. The Import 

Language Database window opens. Select the language of the translation file.  

For example, if the translation file is for Italian, select Italian (Italy) from 

the drop-down list. 

https://www.cdc.gov/epiinfo/support/downloads/translations.html
https://www.cdc.gov/epiinfo/support/downloads/translations.html
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 Import Language Database Drop-down 

3. Click on the Open button. Select the location of the translation file. In this 

example, open the file named ItalianEpi7.mdb. 

 

Open Translation File dialog box 

4. Click the Connect to Data Source button. 

5. Click the Browse button and locate the translation file you want to import. 

6. If there is a password on the file, enter the password, and click OK. 
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7. Select CulturalResources from the Data Source Explorer list. 

 

Data Source Explorer 

7. Click OK. The imported language is added from the list of available 

languages on the Language tab of the Options dialog. 

 

Import Translations button 
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How to Choose a Language 

 

The following steps will show you how to choose a language from those already 

imported into Epi Info™ 7. 

1. From the Epi Info™ 7 main menu, select Tools > Options. 

2. Click the Language tab. 

3. Select the desired language. In this example, select Italian (Italy). 

 

Dialog box in Italian 

4. Click OK. 

For the language to take effect, close and reopen Epi Info™ 7. 
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Conventions in this Guide 

This chart describes typographic conventions used in this document. 

Example of Convention Description 

Boldface type  Emphasizes heading levels, column headings, and the following 

literals when writing procedures:  

• Names of options and elements that appear on screens. 

• Specific operations or features of the Epi Info™ 

Program 

• Keys on the keyboard. 

• User input for procedures. 

• Syntax 

• Captions 

<python> Special characters that highlight coding language included in 

plain text. 

Consolas Font Used for samples of coding language. 

 

Syntax Notations 

The following chart lists the syntax descriptions used in this documentation. 

Syntax Description 

Bold Epi Info™ 7 commands and reserved words are shown in bold type. 

<parameter> Information to be supplied to a command or function. Parameters are enclosed 

with less-than and greater-than symbols. Each valid parameter is described 

following the statement of syntax for the command. Parameters are required by 

the command unless they are enclosed in braces { }. Do not include the < > or { } 

symbols in the code. 

[<variable>] Brackets [ ] around a parameter indicate the possibility of more than one 

parameter. Do not include the < > or [ ] symbols in the code. 

https://www.cdc.gov/epiinfo/user-guide/reserved-words/reservedwords.html
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{<parameter>}  Braces { } around a parameter indicate an optional parameter. Do not include 

the { } symbols in the code. 

| The pipe symbol ‘|’ denotes a choice and is usually used with optional 

parameters. An example is seen in the LIST command. Choose one of the 

options or parameters and do not include the | symbol in the code. 

***comment Classic Analysis Comment  

*** Three asterisks at the beginning of a line of code in the Classic Analysis 

Program Editor indicates a comment. Commented lines are skipped when a 

program is run. Commenting lines of code may be helpful to document the 

purpose of a program and for troubleshooting. 

// comment Check Code Single Line Comment  

In Check Code, a // or double slash at the beginning of a line of code in the Form 

Designer Check Code editor indicates a single line comment. Everything to the 

right of the // is ignored when the Check Code runs during data entry. 

Subsequent lines are not commented unless they begin with //. 

  

/* 

comment 1 

comment 2 

… 

comment n 

*/ 

Check Code Multi-Line Comment  

In Check Code, a /* or slash-asterisk indicates the beginning of a multi-line 

comment and a */ or asterisk-slash indicates the end of a multi-line comment. 

All lines that appear between /* and */ are skipped when the Check Code runs 

during data entry. This is helpful to document the purpose of the code and for 

commenting large portions of Check Code for troubleshooting. 

Both /* and */ must appear at the left margin of the editor. 

" " Straight Quotation marks must surround all literal text values. 

Note: Some text editors such as Microsoft Word, use "smart quotes", but these 

smart quotes are not recognized or cause unanticipated behavior in some 

situations. Use only straight quotes such as "these" around your text strings in 

Epi Info™ 7. 

Example: DIALOG "Notice: Date of birth is invalid" runs the DIALOG 

command to display a message with the text shown in quotes. 
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This guide and other Epi Info™ products are in the public domain and may be freely copied, 

translated, and distributed. You can visit the CDC.gov Epi Info™ products page for more 

information. 

DISCLAIMER 
The Centers for Disease Control and Prevention (CDC) provides the Epi Info™ software, translation 

databases, instructions, examples, sample projects with data, map files, and all other products 

available on this site (the products) on an “AS IS” BASIS, WITHOUT WARRANTIES OR 

CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any 

warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS 

FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of 

using or redistributing the products and assume any risks associated with your use or redistribution 

of the products.  In no event and under no legal theory, whether in tort (including negligence), 

contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent 

acts) or agreed to in writing, shall CDC or the Department of Health and Human Services (HHS) be 

liable to you for damages, including any direct, indirect, special, incidental, or consequential 

damages of any character arising from the use or inability to use the products (including but not 

limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and 

all other commercial damages or losses), even if CDC or HHS has been advised of the possibility of 

such damages. 

Epi Info™ is a trademark of the Centers for Disease Control and Prevention (CDC).  CDC does not 

endorse any commercial product or service, including any subjects of analysis or datasets.  Any 

references on this website, in materials downloaded from this website, or within the products to 

specific commercial products, processes, or services by service mark, trademark, manufacturer, or 

otherwise, does not constitute or imply their endorsement, recommendation, or favoring by CDC. 

https://www.cdc.gov/epiinfo/
https://www.cdc.gov/epiinfo/
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